Extron

Extron Certified DSP Bundle for Microsoft® Teams®
Rooms - Extra-Large Room ¢ Setup Guide

IMPORTANT NOTE:

Go to www.extron.com for the complete user guide, installation instructions, and specifications.

Microsoft Teams and Extron have come together to provide Teams Rooms solutions with our certified hardware. Now it is easier
than ever to stay connected with flexibility of realtime collaboration from anywhere. The products in our Teams Rooms Certified

Design Solutions have been designed and meticulously tested for best-in-class performance and ease of use.

Requirements
Extron Equipment List
Product Description Quantity
DMP 128 Plus C V AT 12x8 Digital Matrix Processor w/ AEC, VoIP, & Dante® 1
XPA U 1004 SB Four Channel Bridgeable Output Amp, 100/200 Watts 1
IPCP Pro 255Q xi Control Processor with LinkLicense Ul upgrade 1
SF 26CT LP 6.5" Low profile, 2-way Ceiling Speakers, pair 3
RSU 129 1U 9.5" Deep Universal Rack Shelf, Gray 1
SPK14P 14 AWG Plenum Speaker Cable - 150' (45.7 m) 1
USB CFG cable USB A Male to USB Mini B Male 6' (1.8 m) 1
MLC PW Audio cable Audio patch cable for audio DSP output to amplifier input - 6' (1.8 m) 1
Network cable UTP RJ-45 Cat-5e Plenum network cable - 35' (10.7 m) 1
Network cable UTP RJ-45 Cat-5e Plenum network cable - 50' (15.2 m) 1
Network cable Cat-6 cable non Plenum - 6’ (1.8 m) 2
Sennheiser® Equipment List
Product | Description | Quantity
TeamConnect Ceiling Medium | Beamforming Ceiling Microphone array | 2
Additional Required Equipment

Product | Description | Quantity
Teams Rooms computer Teams Rooms computer with camera and control interface 1
Network switch 10-port PoE network switch 1
Windows® computer or laptop Computer MUST contain the following: 1

e Extron DSP Configurator

e Extron Global Configurator Plus and Professional

e  Extron Toolbelt

e Dante Controller

e Sennheiser Control Cockpit

e  Extron system configuration *.zip files
NOTE: The Windows computer or laptop is required for adjustments and can be disconnected after system configuration.
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SYSTEM DIAGRAM
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Figure 1. System Diagram Example

NOTE: The supplied network switch is manageable. However, the default configuration is sufficient for this solution to
function.
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Installation Details

Audio Cables

See figure 2 for the connections needed between the DMP Plus and the XPA U amplifier. Use the supplied balanced audio cable to
connect each product.

Tip + Tip .
Ring ! Ring '
Sleeve < Sleeve (s) < ——
Tip +
Balanced Output Ring '

% (5 mm) MAX.
DMP Plus 3-pole XPA U 5-pole Do not tin
Audio Output wiring Balanced Dual Mono Input the wires!

Figure 2. Captive Screw Audio Cable Wiring

Amplifier and Speaker Installation

During installation of the amplifier and speakers, please ensure that their settings are compatible. Set the XPA U amplifier Output
Mode to Bridged Mono, 70V. Set each SF 26CT LP rotary tap selector switch to 70 V, 16W.

For detailed setup instructions please see the XPA Ultra Series Setup Guide and SF 26CT LP Setup Guide at www.extron.com.

Adjust the Tap Selector

Figure 3. Adjusting the Speaker

Configuration Overview

1. Unbox and connect the provided hardware using the diagram in figure 1 on page 2.

NOTE: Do not connect the USB cable between the Microsoft Teams Rooms computer and Extron DMP Plus until after
the Extron DMP Plus is completely configured.

2. Install the following software utilities on the computer:
e  Extron DSP Configurator Software
e  Extron Global Configurator Plus and Professional
e  Extron Toolbelt
e Dante Controller Software
e Sennheiser Control Cockpit Software
3. Download the following from the Extron website (www.extron.com):

e Extron Extra Large Conference Room System File .zip folder
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Sennheiser TeamConnect Ceiling Medium Setup

Sennheiser TeamConnect Ceiling Medium

A single network cable connection from the Sennheiser TeamConnect Ceiling Medium (TCC M) to the network switch supports PoE
into the microphone, Dante audio, and LED feedback for call and mute status. The browser-based Control Cockpit interface detects
and identifies the TCC M when the network cable is attached to the PoE IN/Ctr1l port and the microphone is powered on.

Device List 0/2 devices

TCCM-A

TCCM-B

Figure 4. Control Cockpit Interface
From this interface, carry out the following actions:
e Setting Network Settings

e Beam-steering and Exclusion Zone Adjustments (Optional)
Setting Network Settings
Select the Network tab to configure and document the IP address and host name of the device. This is required later.
Properties
o Audio G s Device ha Network
TeamConnect Ceiling Medium 1
Ethernet Settings MAC Address ®

IP mode Fixed IP Ethernet 00:1B:66:00:00:00

mDNS On Il

P 192.168.254.250
Subnet 255.255.255.0
Gateway 0.0.0.0

OK Cancel

Figure 5. Control Cockpit Network Interface
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Setting Up Third-party Access

Properties

o Audio
TeamConnect Ceiling Medium 1 =«

3rd Party Access Device Access

Access Activated Password pistntatrhokbrikebets
Usemame api

Password TrErEErETEEE

Figure 6. Setting up Third-party Access

1. Select the Access tab to enable 3rd Party Access and configure a 3rd party Password.

2. Document the 3rd party password for the device. This is required later.

Beam-steering and Exclusion Zone Adjustments (Optional)

If additional settings are required to reduce background noise of items such as HVAC, projector fans, or credenzas, the TCC M has
a Priority Zone and up to five Exclusion Zones, which can be leveraged to remove these from the microphone pickup.

To configure a zone:

1. Select the desired unit from the Device List (see figure 4 on page 4). A Properties dialog box opens.

Select the Zones tab. The 3D Overall View shows the real-time focus of the TCC M automatic beam-steering (see figure 7).

2
3. Enable a Priority Zone or Exclusion Zone.
4

Edit the vertical and horizontal angles of the selected exclusion zones (see figure 8) to remove the observed noise.

NOTE: See the TeamConnect Ceiling Medium instruction manual for more information.

Properties
o Audio @ Zones
TeamConnect Ceiling Medium 1 selecte
Zones ® 3D Overall View ®

Rotate the 3D model by dragging it
to the left or right with the mouse
cursor.

Priority Zone

ne 1
Exclusion Zones

On

Beam
2470 / 14°

Figure 7. Control Cockpit Zones Tab

Properties
o Audio @ Zones
TeamConnect Ceiling Medium 1
Zones (0] 3D Overall View @

Exclusion Zone 1 Rotate the 3D model by dragging it
to the left or right with the mouse

:7 cursor.

Vertical Zone: 0° / 10°

Beam

Horizontal Zone: 0° / 0° 247 [ 18

Apply  Revert

Figure 8. Control Cockpit Exclusion

Zones Adjustment



Extron Certified DSP Bundle for Microsoft® Teams® Rooms - Extra-Large Room ¢
Setup Guide

Dante Controller Setup

Dante Controller from Audinate® is required to route transmitters and receivers, and can be used to configure Dante settings and
monitor performance.

Creating Subscriptions Between the Sennheiser TCC M and the Extron DMP 128 Plus C V AT

Ensure the laptop, DMP 128 Plus C V AT (Dante), and TCC M (Dante) are connected to the same network.

2. From the Windows Start menu select: A11 Programs > Audinate > Dante Controller. The Dante Controller - Network
View screen opens. The Dante Controller auto-discovers Dante devices on the network and advertises itself to allow other
Dante-enabled devices to communicate with it. Transmitters connect to receivers using the subscription matrix.

& Dante Controller - Network View
File Devices View Help
U m e @S H e
| DeviceInfo Clock Status  Network Status  Events
°wY
553
oo E
Filter Transmitters iy =
- 858
s g0
Filter Receivers E C
| £
g
%
R
=
+
+/ = Receivers (3)
+ DMP128P-123456 +
+ TCCM-123456 + +
+ TCCM-abedef ¥ [ E

Figure 9. Routing Tab of the Dante Controller Network View

NOTE: The DMP 128 Plus C V AT and TCC M Dante connections are set to DHCP by default. If they cannot be
discovered, ensure the correct interface is selected on the PC by selecting Interfaces from the File menu.

3. Open the Device View of the DMP 128 Plus C V AT by double-clicking the device name in the Receivers list.
4. Inthe Receive tab, click on the first channel name and rename it TCCM-A.

& Dante Controller - Device View (DMP128P-123456) -_ O X

File Devices View Help

9B @ < H & v ]
| Receive Transmit Status Latency Device Config Network Config AES67 Config
Receive Channels Available Channels
Channel Connected To Signal

+-DMP128P-123456

) TCCM-A
e # TCCM-123456
| O + TCCM-abedef
) Exp_In-03

Figure 10. Receive Tab of the DMP Plus Device View
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5. Select the Transmit tab.

6. Click the first channel name and rename it TCCM Ref.

@ Dante Controller - Device View (DMP128P-123456) = a X

File Devices View Help
o B @ < H & DMP128P-1234560% ®

Receive Transmit Status Latency Device Config MNetwork Config AES67 Config
Transmit Channels Multicast Transmit Flows

| Channel Signal
| output-01
|y output-02
| 3 output-03
| output-04
| 3 output-0s
| 3 output-0s
| ) output-07
| (3 output-08
| ) TCOMRef
| €3 Exp_out02

Figure 11. Transmit Tab of DMP Plus Device View

7. Select the Device Config tab and rename the DMP 128 Plus C V AT as desired.
8. Click Apply.

& Dante Controller - Device View (DMP128P-123456) - a X

File Devices View Help
S B @ < Ea DMP128P-123456 (2]

Receive Transmit Status Latency Device Config Network Config AES67 Config

Device

DMP128PlusCVAT Apply

Press ESC to cancel editing. Names must not begin or end with - (dash).

Figure 12. Device Config Tab of DMP Plus Device View
9. From the Device View drop-down menu, choose one of the TCC M devices (see figure 13, @).
10. In the Device Config tab, rename the TCC M microphone to TCCM-A.
11. Repeat steps 9 and 10 for the second TCC M device and rename it TCCM-B.

& Dante Contreller - Device View (TCCM-abedef) - a X

File Devices View Help

£ N @ «< H a TCCM-abedef o ')

Receive Transmit Status Latency Device Config Network Config AES67 Config

Device
TCCM-B| Apply

Press ESC to cancel editing. Names must not begin or end with - (dash).

Figure 13. Device Config Tab of TCC M Device View
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12. Close the Device View window and return to the Network View window.

13. To show the receivers of the DMP Plus device, click the + box next to the desired device in the Receivers list. The + sign
changes to a - sign when the list expands.

14. Click the intersections of the desired subscriptions between transmitter and receiver channels (see figure 14, @).

& Dante Controller - Network View

File Devices View Help
U9 @& & S H 0@

Routing Device Info Clock Status  Network Status  Events

@aDante

Filter Transmitters

TCCM-B

DMP128PlusCVAT +

TCCM-A —
FarEndOut O
Localout 2
FarEndout
Localout D

Filter Receivers

-+ [ |Transmitters (3)

+/ |~/ Receivers (3) o
~DMP128PlusCVAT H |I= =

) TCCM-A &
QTccMs
Q) Exp_In-03

ag

L/

Figure 14. DMP Plus Subscriptions to TCC M

15. To show the transmitters of the TCC M, click the + box next to the desired device in the Dante Receivers panel (see
figure 14). The + sign changes to a - sign when the device expands.

16. Click the intersections of the desired subscriptions between transmitter and receiver channels (see figure 15, @).

& Dante Controller - Network View
File Devices View Help
Lo m*ka@He O
Routing Device Info Clock Status  MNetwork Status  Events
] + [#
Dante : 1
apan £000000N0N0NANNNNNNNNNNNKNAN T =
oD TUYR SN TSRS MM TLD o
A R e kotintnd =] =
Filter Transmitters %‘g‘é‘é‘é‘é‘é‘g‘gz‘:":“:“:“:“:“5‘5‘:"5‘5‘5‘:“:“5
: BEEEEEE2EE5606060600606000060070505,
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Filter Receivers £
T S
=
g
£
]
L
=
+
+/ = Receivers (3)
+/DMP128PlusCVAT g & -+
— TCCHM-A = +
() FarEndRef & &
TCCM-B = +
) FarEndRef & )

Figure 15. TCC M Subscriptions to DMP Plus

NOTES:
e The FarEndOut transmitter channels of the TCC M devices should be routed to the first two receiver channels of
the DMP 128 Plus C V AT. A check mark at the intersection indicates the subscription is made. A check mark also
appears next to the receive channel.

e The TCC M Ref transmitter channel of the DMP 128 Plus C V AT should be routed to the FarEndRef receiver
channel of each TCC M.




Extron Certified DSP Bundle for Microsoft® Teams® Rooms - Extra-Large Room ¢
Setup Guide

Extron DMP 128 Plus C V AT Setup

To configure the Extron DMP 128 Plus C V AT, perform these steps:
1. Set IP address via embedded web page.

2. Set the computer or laptop IP address within the range of the product IP address. The default settings are (LAN for
non-V models, LAN 1 for V models):

e |IP Address: 192.168.254.254
e Subnet: 255.255.255.0
e Gateway: 0.0.0.0

3. From a web browser, enter the device IP address into the address field.

NOTE: If the local system administrators have not changed the IP address, and the device has not been assigned an IP
address via DHCP, the default address (LAN for non-V models, LAN 1 for V models) is 192.168.254.254.

Press Enter.
On the login page, enter admin as the Username, enter the Password (if one has been set), and click Sign In.

e By default, the password is the product serial number.

e If a Full Factory Reset has been performed, then the password is clear and the Password field can be left blank.

Extron DMP 128 Plus C V AT

Digilaal audio miabiix processur wilh AEC, VoIP, and Dante

SIGN IN

Figure 16. Login Page

6. The Communications Settings panel displays TCP/IP communication settings. Click Edit to open the Communication
Settings dialog box and edit the TCP/IP settings.
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The following can be edited: DHCP status, IP address, subnet mask, and default gateway. This dialog box also displays the
device MAC address. To revert the computer IP address to a range which can communicate to the new IP address schema.

NOTE: If DHCP is enabled, IP address, subnet mask, and default gateway cannot be edited.

DMP 128 Plus CV AT
Digital audio matrix processor with AEC, VoIP, and Dante Extron.

Firmware: v1.11.0000

Logged in as: admin

Communication Settings - LAN 1 Device Info Date/Time Settings
TCP/1P Device Name: DMP-128-Plus Date: Thursday, October 12, 2023
Host Name: DMP-128-Plus Part Number: 60-1513-10 Time: 05:41:33 PM
DHCP: Off Model Name: DMP 128 Pius C V AT Timezone: (UTC+00:00)
1Pvd 1P Address:  192.168.254.251 Description:  Digi i ix processor wi
Subnet Mask: 255.255.255.0 o ' :'%m?n - e
(i U 00.00 Firmware Version:  1.11.0000-b00&
Mac Address: 00-05-A6-AB-34-EF
Temperature: 117.5/47.5°C
e Dante Device Info N
Baud Pat 38400 Device Name: DMP128PIusCVAT
Parity Bit: None Firmware Version:  2.0.1.0
Data Bit: 8
Stop Bit: 1
Configure This Device
To configure this device, download and install DSP Configurator.
http:ffvaww.extron.com/download/

Figure 17. Communications Settings Panel
To push the DSP Template file to the DMP Plus:
1. Open the Extron DSP Template file (downloaded previously in .zip file) with DSP Configurator software.

2. Connectto a DMP 128 Plus C V AT in Live Mode by clicking the Live button in the menu bar of DSP Configurator (see
figure 18, @). Alternatively, select Tools > Connect to Device or press <F6> on the keyboard. The Connect to Device
dialog box opens.

Live ‘:HEmul.ate s

Figure 18. Live Button
3. Click the TCP/IP tab in the dialog box.

Enter the IP address of the device in the Hostname or IP Address field. If necessary, enter the device password in the
Password field.

10
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5. When a connection type with a device is established, the Synchronize with Device dialog box opens. Select Push.

B synchronize with Device = O X

You have elected to change from Emulate mode to live mode. The data in
this configuration must be synchronized with the data in the device. Please
select an option below to continue:

QO Pull data from the device and update this configuration.

Push the data from this configuration to device, overwriting any data
@ currently in it. The device will disconnect after the push if the
configuration and all the presets are not sent.

Push Configuration
1 Push AT Input Channel Names
Push Presets

® Al
O Selected

NOTE: Pushing presets may cause the device to
cycle through each preset that is pushed. This
should not be performed during live operation.

Cancel

Figure 19. Synchronize with Device Dialog Screen
6. Click oK.

Once the push is completed, the current state of the connected DMP 128 Plus C V AT is displayed in the DSP Configurator
status panel and the device is ready for further configuration.

USB Naming
The USB Audio tab allows for customizing USB audio interface . . ,
names and terminal types (see figure 20). B oevice Settings ¢ X
NOTE: Extron recommends configuring these settings Unit Info ' IP Settings Passwords = Serial Settings
before connecting USB audio devices to a PC. Date/Time USB Audio 'Dante Device

To configure USB Audio settings in DSP Configurator: Enter a USB Name for the USB Audio interface.

1. From the Tools menu, select Device Settings. The lﬂgﬁs‘t\t‘(ﬁyfhe L5 BT ERAT lE
Device Settings dialog box opens.
Click the USB Audio tab. USB Name : Extron DMP Plus

USB Name can be up to 32 characters drawn from the

In the USB Name field, enter the desired name for the USB alphabet (-2, digis (0-9), and special characters

Audio interface. including underscore(_), backslash(\), and spaces.
4. Inthe USB Terminal Type panel, choose Echo Cancelling .
Speakerphone. USB 1 Terminal Type

Appear as:
@ Echo Cancelling Speakerphone

O Speakerphone

Click Apply to activate the new settings.
Connect the USB Audio port to the PC.

0K Cancel

Figure 20. USB Audio Tab
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Extron IPCP Pro 255Q xi Setup

The Control Procesor in this system facilitates the communication between the Extron DMP Plus and Sennheiser TCC M.

Get Ready

1. Download and install the latest version of the following software:

¢ Toolbelt — for discovering the control processor and other control products on the network, for managing core settings,
and for upgrading firmware when needed.

¢ Global Configurator Plus and Professional (GCP) — for configuring the control system

2. Obtain network information for the unit from the network administrator. You also need the following details for each Extron Pro
series Ethernet-enabled device:

¢  DHCP setting (on or off) e Subnet mask e Username
e LAN IP address e Gateway IP address e Passwords
e AV LAN IP address

NOTE: If DHCP is on, you do not need the IP addresses and subnet mask.

Write down the MAC address of each network interface on each IP Link Pro device to be used.

Obtain model names and setup information for devices the IPCP controls.

Mount and Cable All Devices

1. Cable devices to the control processor.

2. Connect power cords and power on all the devices.

Network Communication Setup

Network setup is essential prior to configuration. Use the flowchart at

right as a guide to setting up the control processor for network use. Network Communication Setup

NOTE: If using 802.1X security, see the Extron 802.1X Connect the PC and the LAN port or AV LAN
Technology Reference Guide and the Toolbelt Help file for port of the control processor to

o . the same network.
additional details on system setup. . to all devi
pply power to all devices.

v

Open the Toolbelt software from within
Global Configurator (GC Professional or
GC Plus mode) or as the stand-alone
application.

Start Device Discovery.

Toolbelt displays a list of all Extron control
devices connected to the network.

y

Using the MAC address, locate the desired
control processor in the list and select it.

v

For each network interface
(LAN, or LAN and AV LAN), use the Set IP
feature in Toolbelt or use the
Toolbelt Manage > Network Settings tab
feature to enter the IP address and
subnet address, then configure other
network settings as needed.

12
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Set Up the Control Processor for Network Communication.
1. Connect the PC to be used for setup and the LAN (or AV LAN) port of the control processor to the same Ethernet network.
2. Start Toolbelt and use it to discover the IPCP Pro 255Q xi:

TE Toolbelt

File Tools Help

ih |+ | o | o2 7.
Discovery | Add Clear Import Export B ! Filter
IP Address Actions Model Name
A 192168254250 3 &% 4L &R IPCP Pro 255Q xi

Figure 21. Discover IPCP Pro 255Q xi with Toolbelt
3. Log on to the unit:

TE Enter your credentials X

® Please provide credentials for 192.168.254.250

EXTRON
192.168.254.250
Usermname
‘adr—.n ]
Password
|...'.. I
[ enter || cancel

Figure 22. Log on to IPCP Pro 255Q xi

NOTES:

¢ The factory configured passwords for all accounts on this device have been set to the device serial number.
Passwords can be changed during configuration. Passwords are case sensitive.

¢ |f the device is reset to default settings, the password is the default password configuration. The default password is
extron (for either admin or user accounts).

4. |If required, change the password:

.

The following shows the login credentials on the device.

el || <BUS |

e —
Current Password New Password
Mew Password Confirm Password
[ ] \ ]
Confirm Password Password cannot be blank
—
Admin password must have
minimum length of 1
character

Figure 23. Change Password

13
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14

Set the DHCP status, IP address, subnet, gateway IP address, and related settings.

The following shows the

k settings related to the device.

Communicate to this device via a friendly-name.

| IPCP-Pro-2550.xi |

[ ooy [ comem ]

Metwork Interfaces

Settings related to the Network Interface Card.
[] Use DHCP (Obtain IP Address Automatically)

IP Address® [192.168.254.249

Subnet Mask* [235.255.255.0
Gateway* |0.0.00
DNS Server 1 |

L
DS Server 3 |
L

Figure 24. Configure Network Settings

NOTES:

¢ When setting up DHCP during network configuration or if using a host name instead of an IP address, the user must
enter a qualified host name (Username.HostName.Domain). For example: somename. extron. com.

¢ Adedicated AV LAN safeguards AV systems from outside intrusion or interference by separating device control and
other network traffic from a corporate or campus network. To ensure that the control processor LAN and AV LAN
connections (ports) are connected to separate networks, the LAN and AV LAN IP address schemes must be on
different subnetworks.

See the Network Communication Setup flow chart on page 12.

If required, apply a LinkLicense.

[t | [t [ e || seitstivs || e | [scory | [ECEEERN

The following shows the LinkLicenses that are applied to this device. Learn More.

b | | [- ] [omr]

You can redeem your LinkLicense by clicking here www.extron.com/LLRedeem

No LinkLicenses found.

Figure 25. Apply LinkLicense
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Configure or Program the Control Processor

NOTE: See the Global Configurator Plus and Professional Help File as needed for step-by-step instructions and detailed
information. The help file for GCP includes an introduction to the software and how to start a project and configuration.

Using Global Configurator, configure the control processor. The configuration tells the control processor:

¢ How its ports function

e How to control other products

¢ Whom to notify, how, and under what circumstances

Configuration with GC Plus

1. Open the provided GC Plus configuration file. The software opens to Configuration view ([=]). This option is also selectable
from the View menu.

5 Global Configurator

File Project View Build Tools Help

| PCP Pro 2550 MTR
IPCP Pro 255Q xi

DEAl, =|elef. |al&|elw|.

IPCP Pro 255Q % : MTR > System Settings

& dlod

System.

Settings pon:

¢ How its ports function
e When to do things

System D 1234
Configuration Palette - o

Name IPCP Pro 255Q x : MTR ] [ Make Glopatviewer Host
1P Address/Hostname 192.165.254.250 v
IP Address/Hostname (AVIAN) | 132.166.254.252 2 v
e Password O - I
‘System Information
Must be 4 digits and within the range 00¢
Live Hardware Information z

LAN
1P Address

Device Information

Hostname.

Figure 26. Configuration View — System Settings page for Control Processor

2. Setthe IP address (see figure 26, @), and Admin password (€)) of the Control Processor, and, IP address for AV LAN (€)).

NOTES:

extron.

¢ The factory configured passwords for all accounts on a device are set to the device serial number. Passwords are
case sensitive.

e [f the device is reset to default settings, the password is the default password configuration. The default password is

3. Open the Communications Ports page (@).

¢ Global Configurator

File Project View Build Tools Help

i P Pro 25506 : MR
IPCP Pro 255Q xi

Dlela). {=lee. [al#le[w].

IPCP Pro 255Q xi : MTR > Communication Settings > Ethemet Port 1 - Extron - DMP 128 Plus C V ATv5.0

Configuration Palette.

Communication Ports

@D serial Port 2

1R/Serial Port 1

Sennheiser - TeamConnect Ceil
Ethemet Port 2
Sennheicer - TeamConnect Ceil.
Ethemet Port 3

£ S ———
‘. Extron - DMP 128 Plus CV AT .. 1‘
Ethemet Port 1

Serial over Ethernet|

Ethernet Settings

Auto-mixer Gate Set ( Input, Value )

Auto-mixer Gate Status ( Input , Value )

1P Address/Hostname
1192.168.254.250
SSH Port
22023
I Driver Settings ————o{

Username
admin
Password

e 3 —

( Value )
Digital Input Status ( Input , Value )

Input Signal Level Monitor ( Inout , Monitoring
Input Source ( Input , Value )

Macro ( Macro., Value )

Mix-point Gain ( Input, Output, Value )

Part Number ( Value )

Phantom Power ( Input , Value )

Preset Recall ( Value )

Preset Save ( Value )

USB Call Status ( Value )

User Defined Command

User Defined String ( Value )

Dante AT Input Premixer Gain { Dnte Device
Dante DC Protection Fault ( Dante Device, Val
Dante Digital Clip ( Dante Device, Output, Va
Dante Group Mic/Line Input Gain ( Dante Dev
Dante Group Mix-point Gain ( Dante Device , (
Dante Group Mute ( Dante Device , Group , Va
Dante Group Output Attenuation ( Darte Dev

Dante Group Post-mixer Trim ( Dante Device ,

Name
Polling Interval (sec) _Initialized Only
‘Supported Feedback Live
= T
| Value List (Enum)
Default Line 1 h?

[MI:l A‘
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Figure 27. Configuration View — Communications Ports page for DMP Plus
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Choose DMP P1us under the Ethernet Ports list (see figure 27, @), on page 15).

Set IP address (@) and Admin password of the DMP Plus device (€)).

¢ \\usa-prodman\ProdMgrs\ PERSONAL FOLDERS\Ram Partosa\Extron Campus Configurations\PM2 Test\IPCP-MTR-test-LRG.gcplus * - Plus - Global Configurator

File Project View Buid Tools Help

IPCP Pro 255Q xi

EEEREDERREREE

IPCP Pro 255Q xi : MTR > Communication Settings > Ethernet Port 2 - Sennheiser - TeamConnect Ceiling Medium v1.2

+'%

~ Communication Settings

Configuration Palette

Sennheiser - TeamConnect Ceiling Medium v12 58

R |~ popertes |
I Ethernet Settings o Vel oo e
1P Address/Hostname Beam Direction ( Type , Value ) Desaription
i Deice Name € vatoe » Supported Feedback  Emulated e
Parameters

I Driver Settings

Password

FrrrTT—

Firmware Version ( Value )
Identify Device

Installation Type ( Vaiue )

Value. List (Enum)

Details

Mute { Value ) L pE—
Sensitivity Threshold ( Value ) Activated

[ Name A
Analog Output Gain ( Vatue ) =

S e — S

Analog Output Source ( Value )

Exclusion Zone Azimuth ( Zcne  Min, Max )

Exclusion Zone Azimuth Status ( Zone , Type ,

Exclusion Zone Elevation ( Zone , Min , Max )

Exclusion Zone Elevation Status ( Zore , Type.

Communication Ports

@D Serial Port 2

IR/Serial Ports

Exclusion Zone Mode ( Zone, Value )

Far End Output Delay ( Value )
Far End Output Gain ( Value )
Far End Output Sound Profile ( Value )

IR/Serial Port 1

Input Level Gain ( Value )
LED Show Far End Activity ( Value )

‘ Sennheiser - TeamConnect Ceil.
Ethemet Port

Figure 28. Configuration View — Communications Ports page for TCC M

Choose the first TeamConnect Ceiling Medium under the Ethernet Ports list (see figure 28, @).

Set IP address (@) and password (€)) of the TCC M device.
Repeat steps 6 and 7 to configure the second TCC M device.

© ® N o

Open Build Manager view (see figure 29, @, [E]). This option is also selectable from the View menu.

5¢ Global Configurator

File Project View Build Tools Help

iDuE_iDOIBs“._EﬁQ@_.

Build Options ' Controllers
I A IPCP Pro 255Q xi : MTR
b ) - IPCP Pro 255Q xi
Hardware
Configuration

I Build & Upioad

Build Progress

Upload Progress

Figure 29. Build Options panel

10.
1.

Under the Build & Upload section, click the Build button.
Wait for Verification. The Build and Upload bars show the progress.

Build Options
b Verification se——
Hardware

Complete

Configuration

Complete

F Build & Upload

Build Progress
Complete

Upload Progress

Complete

Figure 30. Build and Upload Completed

12. Once the process is complete, the Build and Upload bars both show the message Complete (see figure 30).
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Test and Troubleshoot

Test the system (see the IPCP Pro Q xi and xi Series User Guide for an outline of the system testing procedure). Make adjustments
to wiring or configuration as needed.

Microsoft Teams Rooms Setup

The Extron DMP 128 Plus connects to the Microsoft Teams Rooms system from the USB Audio port. Once the previous steps
outlined in this document have been completed, please connect the Microsoft Teams Rooms system to the DMP 128 Plus USB
Audio connection via the provided USB mini-B cable.

The following steps detail the required settings on the Microsoft Teams Rooms device:

Select Settings (see figure 31, @) in the Microsoft Teams Rooms interface.

X H

Meet now Join with

an ID

i C 0O

Accessibility Restart Settings
device

Figure 31. Microsoft Teams Rooms Setup

Microsoft Teams Rooms Interface Screen

Select the Extron DMP Plus (or configured USB Name in above steps) for each of the two parameters: Microphone (see
figure 32, @) and Speaker (@).

Settings

® About Audio Cameras
@ Microphone for Conferencing Default Video Camera

Account
Speakerphone (DMP Plus US... None
= Advanced

@ Bl on oy nci @ EED
Meetings

Echo Cancelling Speakerphone (DMP Plus US...

Device

b ——@ 75

Coordinated meetings
Default Speaker

Peripherals
Echo Cancelling Speakerphone (DMP Plus US... v

Select a background C— @ 75

SR Windows Settings O

Reset Device Exit without saving Save and exit

Figure 32. Microsoft Teams Rooms Interface

Microsoft Teams Rooms Settings Menu

NOTE: When using the Extron DMP 128 Plus, Microsoft Teams Rooms Rooms disables its internal acoustic echo
cancellation (AEC) audio processing so that all audio processing is completed through the external DSP—the Extron
DMP 128 Plus. This provides the best audio performance.
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Troubleshooting

DMP Plus Acoustic Echo Cancellation (AEC)

AEC Setup Overview

Proper gain structure involves the relationship between the signal at the selected reference and the signal at the mic input, within
the context of proper levels for the reference and mic inputs independently. The mic input gain setting is naturally optimized for the
voice level of the talker in that room. Therefore, the amount of signal from the far end that is picked up by the mic is dependent on
how much that far end signal is being amplified in the near end room and the distance from the mic to the speakers.

The reference signal is the signal received from the far end, which arrives at the USB-assigned Aux Inputs of the DMP Plus. This is
sent to the sound reinforcement system within the near end room, as well as a designated output channel to set the reference level
for the DMP Plus AEC processor.

AEC Dialog

The AEC dialog in DSP Configurator contains meters and indicator LEDs that are essential for setting up gain structure and
monitoring activity.

O AEC Activity Indicators (on the following page)

e Far - lights when activity is detected from the remote site.
e Near - lights when activity is detected from the local site.

e Update - lights when the AEC is updating (converging or reconverging)

© Meters

[CJ
o

(£

e ERL —the ratio in dB between the signal at the reference and the signal at the AEC
channel input. When ERL is a positive number, the signal level at the AEC channel
input is lower than the signal at the selected reference.

NOTE: The ideal level range for this meter is 0 to +15 dB. This ensures the right
amount of reference signal is being sent through the AEC processor.

e ERLE - the amount in dB of potential echo signal that the AEC algorithm, not including
NLP processing, is cancelling.

e TER —the sum of ERL + ERLE, in dB.

Reference Selection List — The provided configuration includes a selected AEC
reference. If necessary, a different AEC reference can be selected from the drop-down list.

Noise Cancellation Controls — Noise cancellation can be switched on or off from the
AEC dialog. The noise canceller will detect steady state noise, such as HVAC or other
continuous system noise, and effectively remove it without causing audible artifacts.

Advanced AEC Controls — Click expand and collapse icon to expose the advanced AEC
controls.

Advanced control functionality is as follows:

¢ Non-linear Processing (NLP) Controls:

TCC M- AEC ? X
Activity
o Far: Near: mm Update: mm

ERL ERLE TER
LevedindB

Leved indB Leved indB

oI | K

i i -30

5 510 Ifm 20

S -0 -20 -10

% 10 0 E

= B . --10

--20 -0 --20

E E BE
Reference: |AEC Ref (VitiRet #P) v|

Noise Cancellation

0Car\oo@INoiseby: 150 £/ dB

Bypass OK Cancel
N
Enable NLP
NLP Presets:
Soft Nomal Aggressive

Max NLP Reduction:  45.0 dB
Atack Time: 5.0

Release Time: 50.0

ms

O

ms

Double Talk Echo Reduction: 120 3 dB
Comfort Noise: 0.0 = ]

Figure 33. AEC Controls

e  Enable NLP — This box is selected by default. Non-linear processing is necessary for the complete removal of echo.

e NLP Presets — Click a button to load a set of values to the three NLP parameters. If not using one of these presets,

enter values into the fields for the following three controls:

¢ Max NLP Reduction — The maximum possible reduction in echo artifacts that can be applied

e Attack Time — The speed in which NLP is applied
e Release Time — The speed in which NLP is released
e Additional Controls:

e Double Talk Echo Reduction — Sets the amount of echo reduction applied during double-talk (when two people

speak at the same time).

e Comfort Noise — Sets a comfort noise level in dB to eliminate states of complete silence, which may be perceived as

a failed connection.
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Technical Support

For Extron technical support, visit: www.extron.com/company/contactus.aspx.

For Sennheiser technical support, visit: sennheiser.com/service-support.
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For information on safety guidelines, regulatory compliances, EMI/EMF compatibility, accessibility, and related topics, see the Extron
Safety and Regulatory Compliance Guide on the Extron website.
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